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GUI Software Installation

Chapter 1
SLDU023–November 2016

GUI Software Installation

The PGA970 GUI allows the users to communicate to the PGA970 EVM. The following section explains
the location and the procedure for installing the software properly.

NOTE: Do not make any USB connections to the EVM until the installation is complete.

1.1 System Requirements
• Supported OS – Windows XP or higher
• Recommended RAM memory – 4GB or higher
• Recommended CPU Operating Speed – 3.3 GHz or higher

1.2 Installation Procedure
The following procedure describes the steps involved in the PGA970 GUI installation.
1. Double click on the Setup_PGA970_EVM.exe from the installer folder as shown in Figure 1-1.

Figure 1-1. Setup_PGA970_EVM.exe

A screen shown as in Figure 1-2 appears.
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Figure 1-2. Installation Initialization
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2. The License Agreement for PGA970 GUI appears as shown in Figure 1-3. Read through the
agreement carefully, enable the “I accept the agreement” option and click the Next» button.

Figure 1-3. License Agreement – GUI
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The License Agreement for National Instruments appears as shown in Figure 1-4. Read through the
agreement carefully and enable the “I accept the agreement” radio button and click the Next» button.

Figure 1-4. License Agreement - NI
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The License Agreement for Python 2.7 appears as shown in Figure 1-5. Read through the agreement
carefully and enable the “I accept the agreement” option and click the Next» button.

Figure 1-5. License Agreement - Python

NOTE: It is highly recommended to keep the default values as provided in the installer.
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3. Set the destination directories for the PGA970 GUI installation and click the Next» button as shown in
Figure 1-6.

Figure 1-6. Destination Directory
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4. A screen as shown in Figure 1-7 appears. Click Next» to begin the installation.

Figure 1-7. Start Installation
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5. The installer begins self-extraction and proceeds with the installation as shown in Figure 1-8.

Figure 1-8. Installation in Progress
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6. Python installation starts towards the end of PGA970 GUI installation. Select the required option and
click the Next» button.

Figure 1-9. Python Installation
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7. Select the installation folder for Python and click the Next» button.

Figure 1-10. Python Installation Directory
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8. A dialog as shown in Figure 1-11 appears. Click the Next» button to proceed with the installation.

Figure 1-11. Python Customization
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9. Python installation starts. The progress is updated as shown in Figure 1-12.

Figure 1-12. Python Installation Progress
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10. After the completion of Python installation, click the Finish button.

Figure 1-13. Python Installation Complete
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11. The USB2ANY installation starts after the completion of Python installation. From the dialog shown in
Figure 1-14, click the Next» button.

Figure 1-14. USB2ANY Installation
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12. The License Agreement appears as shown in Figure 1-15. Read through the agreement carefully and
enable the “I accept the agreement” option and click the Next» button.

Figure 1-15. USB2ANY License Agreement
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13. Set the destination directories for the USB2ANY installation and click the Next» button as shown in
Figure 1-16.

Figure 1-16. USB2ANY Installation Folder
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14. After the installation is completed click the Finish button.

Figure 1-17. USB2ANY Installation Complete
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15. The screen as shown in Figure 1-18 appears and denotes the end of the PGA970 GUI installation.

Figure 1-18. Installation Complete

CAUTION
The PGA970 GUI requires the following software to be installed before the GUI
is executed.
• National Instruments LabVIEW Run-Time Engine 2012:

www.ni.com/download/labview-run-time-engine-2012/3433/en/

NOTE: The PGA970 GUI executable has been built in LabVIEW 2012 (32-Bit) version and it expects
the LabVIEW Run-Time Engine version to be LabVIEW Run-Time Engine 2012 (32-Bit)
Version.

http://www.ti.com
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SLDU023–November 2016

PGA970 – User Interface

This section gives a detailed description of the features of the PGA970 GUI.

The PGA970 GUI is an intuitive UI, for the PGA970 device and EVM that allows the user to read and
configure the registers of the PGA970 device and control some EVM components.

NOTE: It is advised to launch the PGA970 GUI with administrator privileges.

When the PGA970 GUI is launched, the following screen pops up indicating that the GUI is initializing.

Figure 2-1. GUI Initializing
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When the PGA970 GUI is launched for the first time, a pop-up window (as shown in Figure 2-2) appears
on the screen.
1. Click the YES button on the pop-up for the GUI to run as expected. This updates the Python

installation path in the Windows registry, so that, when the macro window is launched from the GUI,
the IDLE IDE is called.

Figure 2-2. Update Registry

2. After the PGA970 GUI is launched, the user can invoke it in two different ways:
• Interface Disconnected
• Interface Connected
Interface Disconnected mode is invoked when the USB2ANY is not connected. When the PGA970 GUI
is loaded with no hardware interface connected, a message pops up as shown in Figure 2-3. This
allows the user to either run the PGA970 GUI in Interface Disconnected mode or to terminate the
usage.

Figure 2-3. Device Communication Error

When the user continues in Interface Disconnected mode, the checkbox at the top of the GUI is set.
This shows that the PGA970 GUI is running in USB2ANY Disconnected mode. When the GUI is in
Interface Disconnected mode the UI controls may appear to function as if the device is connected and
will read simulated data.

http://www.ti.com
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2.1 PGA970 GUI Overview
The PGA970 GUI consists of the following pages:
• High Level Configuration Pages

– Interface Settings
– ADC Settings
– ADC Capture
– DAC Settings
– FRAM & DEVRAM

• Low Level Configuration Page

Interface Settings
• UART speed settings for OWI
• Rloop resistance configuration
• Additional voltage configuration

ADC Settings
• The page contains the settings for the ADCs available in PGA970 device.
• The table at the bottom of the page is used to read the ADC register values and display the

corresponding amplitudes in volts.
• The data could also be dumped into a file by selecting the corresponding ADC.

ADC Capture
• The ADC Graph allows the user to configure the ADC settings for Capture.
• It has options to perform continuous ADC capture with the configured settings
• This Page also allows the user to export the graph data to a text file or save the graph plot as an

image. Right click the graph for the export options.

DAC Settings
• User can read DAC data and ADC or waveform loopback data. DAC Gain can also be configured here.
• This page has Loopback option that will read back the waveform generated or the DAC values through

the ADC available on the device.

FRAM & DEVRAM
• The PGA970 has FRAM and DEVRAM blocks along with the register memory and these blocks can be

accessed by using the FRAM & DEVRAM page of the PGA970 GUI.
• These memories can be programmed by using HEX files.
• This page also enables the user to read the RAM memory and save it into a file or verify the RAM

contents against a hex file to find if the programmed data and the file data are same.

Low Level Configuration Page
• The Low Level Configuration Page lists down all the registers that are present in the PGA970 GUI.
• This page can be used to write to or read from, the register fields of the PGA970 device.

About Page
• About page can be accessed from Help Menu → About
• The about page contains information such as GUI Name, Version Information and Supported OS.
• It also contains copy-write information of the PGA970 GUI.

http://www.ti.com
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The PGA970 resources could be accessed by the Digital interface or by the Microcontroller. The user can
change how the PGA970 resources are accessed by selecting the microcontroller button at the top left
corner of the PGA970 GUI as shown in Figure 2-4.

Figure 2-4. Microcontroller Selection

The microprocessor can be put into reset state by writing 1 to the MICRO_RESET bit in the
MICRO_INTERFACE_CONTROL register using any of the Digital Interfaces. Access to Digital Interface is
enabled by writing 3 to MICRO_INTERFACE_CONTROL register. Disabling any of the bits that
correspond to the Digital Interface results in disabling the digital interface. (Note: All the pages except
“Low Level Configuration” page and “Interface Settings” page are disabled when the Digital Interface is
disabled.)

2.2 PGA970 Communication Interfaces
The Communication Interfaces are used to communicate (read or write) with the device’s registers. Each
interface uses different pins for communication. The device has two separate modes of communication:
• Serial Peripheral Interface (SPI)
• One-Wire Interface (OWI)

Each communication mode has its own protocol; however, both access the same memory elements within
the device. For all communication modes, the PGA970 device operates as a slave device.

NOTE: Whenever the user changes the protocols, a sequence of operations are performed at the
backend.

During SPI Selection
• The Digital Interface is enabled by writing 3 to MICRO_INTERFACE_CONTROL
• GPIO_OWI_TX is set LOW
• GPIO_OWI_TX is set LOW
• Disables the OWI_XCVR bit in DIG_IF_CTRL register

For OWI Activation
• Digital Interface is disabled by writing 0 to MICRO_INTERFACE_CONTROL
• GPIO_OWI_TX is set to LOW
• GPIO_OWI_ACT is set to HIGH
• Wait for 10 ms (This configuration is hardcoded in the GUI software)
• GPIO_OWI_ACT is set LOW
• GPIO_OWI_TX is set HIGH

2.2.1 Overview of SPI Interface
• SPI is a synchronous, serial, master-slave, communication standard that requires the following four

pins:
– MOSI: SPI Master Out Slave In, input pin
– MISO: SPI Master In Slave Out, serial output pin (tri-state output)
– SCK: SPI clock which controls the communication
– CSN: Chip Select (active low)

• SPI communicates in a master/slave style where only one device, the master, can initiate the data
transmissions.

• The PGA970 always acts as the slave in SPI communication, where, whatever external device that is

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLDU023


www.ti.com PGA970 Communication Interfaces

25SLDU023–November 2016
Submit Documentation Feedback

Copyright © 2016, Texas Instruments Incorporated

PGA970 – User Interface

communicating with it becomes the master. Both devices begin data transmission with the most
significant bit (MSB) first.

• Because multiple slave devices can exist on one bus, the master node is able to notify the specific
slave node that it is ready to begin communicating with, by driving the CSN line to a low logic level.

• In the absence of active transmission, the master SPI device places the device in reset by driving the
CSN pin to a high logic level.

• During the reset state the MISO pin operates in the tri-state mode.

2.2.2 Overview of OWI Interface
• The OWI digital communication is a master-slave communication link in which the PGA970 operates

as a slave device only.
• The master device controls when the data transmission begins and ends.
• The slave device does not transmit data back to the master until it is commanded to do so by the

master. The VDD pin of PGA970 is used as OWI interface, so that when PGA970 is embedded inside
a system module, only two pins are needed (VDD and GND) for communication.

• The OWI master communicates with PGA970 by modulating the voltage on the VDD pin while PGA970
communicates with the master by modulating current on VDD pin.

• OWI Write
– No specific configuration is needed to write using the OWI.
– Write the data in the format defined by the data sheet.

• OWI Read
– The following sequence is executed for the read operation.
– Check if the USB2ANY buffer has residual data and empty the buffer.
– Send the read command with the sync byte, read initialization and read response command as

defined in the data sheet.
– Check for data in the buffer until it receives it.
– Read the data from the buffer and display it. This will read all data available in the buffer. Ideally

there should be only one byte of data.

http://www.ti.com
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2.3 Page Selection

2.3.1 Low Level Configuration Page

Figure 2-5. Low Level Configuration Page

• Low Level Configuration page provides a detailed view of all the registers that the device possesses.
• This page allows the users to read from or write to the registers.
• When a particular register is selected, the corresponding register description is displayed at the bottom

of the page.

http://www.ti.com
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• Register write modes

Figure 2-6. Update Mode

– Immediate mode - The register values will be written to device immediately when a register value
or a field value is changed.

– Manual mode - The register values will be written to the device only when Write Register or Write
Modified button is pressed. The changed register values will be highlighted in blue color which
means that these changes are not yet written into the device. When a highlighted register is written
to the device, the register will again turn into normal state (black). If there are some pending
changes and update mode is changed from manual to immediate, a dialog box will appear. Choose
the required operation to be carried out from the dialog box.

Figure 2-7. Pending Changes Dialog

2.3.1.1 Load and Save Register Configuration Feature
• Save Config - When the user clicks this button, the current register configuration is saved into a file

which can be later loaded into the GUI using the Load option.

Figure 2-8. Save Config

• Load Config - Click this button to load the configuration file which was saved previously to bring the
device into a known state. Ensure that the Microcontroller is reset before the configuration is loaded.

Figure 2-9. Load Config

• When the user selects any of the above options, a message pops up on the screen. Select the file path
(to load /save the configuration file) and click OK

NOTE: Load Config overwrites the existing data in the registers with the value specified in the .cfg
file loaded.

http://www.ti.com
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2.3.1.2 Register Read and Write
The user can change the value of a register by:
• Register level operation

– Select the register to edit
– Double click on the value column corresponding to the register
– Enter the register value (Hex) in the edit box

Figure 2-10. Register Level Value Change

• Field level Operation
– Select the register to edit
– The fields corresponding to the register will be listed in the Field View section
– When the user hovers the mouse over the value of a field, a dropdown list or a numeric control

appears and the corresponding bits get highlighted. The user can change the appropriate value in
the dropdown list or numeric control.

Figure 2-11. Field Level Value Change

• Bit level operation
– Select the register that has to be edited.
– Value of each bit in the register can be changed by clicking the ‘0’ or ‘1’ in the corresponding bit

column. The bits that are greyed out are read only bits. These bits cannot be written.

Figure 2-12. Bit Level Value Change

• The Field View displays the fields of the selected register and value of each field.
• Read Register - When the Read Register button is pressed, the value will be read from the device and

displayed in the Register map tree. The field view will also be updated with the new values.
• Write Register - The field view will display the values to be written to register (field wise view). The

hex equivalent data that will be written to the register is displayed in the value column corresponding to
the selected register in Register Map tree.
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• Read All - When the user presses this button, the data is read from all the registers based on the
mode (Read and Read/Write mode).

• Write Modified - When the user presses this button all the pending registers that are not written to the
device gets written into the device. This option gets enabled only when update mode is Manual.

Figure 2-13. Low Level Page Operations

2.3.2 High Level Configuration Page
• The High Level Configuration Page provides an abstract view of the device.
• Different functions of the device are represented structurally.
• Each control that is placed in the high level configuration page is linked to a register or a field of the

device.

The High Level Configuration pages consist of the following functions. Each of the sections below explain
a different function of the PGA970 EVM.

2.3.2.1 Interface Settings
• The Interface Settings page contains the configuration parameters necessary for the communication

protocols.
• The page includes options for configuring OWI communication.
• The default values are displayed when the GUI is loaded.

Figure 2-14. Interface Configurations

• The user has the provisions to change the Baud rate for the UART protocol.
• The default baud rate for UART it is 4800 bps.
• After the change is made, the Configure button has to be clicked for the changes to take effect.
• The controls Rloop and Additional Voltage are used to configure the Potentiometers on the PGA970

EVM board. These Potentiometers are configured using I2C protocol. The additional voltage
configuration is needed when constant voltage drops (such as diodes) are present in the loop. For the
PGA970EVM, the additional voltage should be set to 0.0 V.

http://www.ti.com
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Figure 2-15. POT Configuration

2.3.2.1.1 OWI Configuration
UART configuration involves 3 settings,
1. Setting the baud rate to the selected configuration
2. Setting the receiver mode to ‘2’

(a) Configures the communication to be half duplex.
(b) USB2ANY transmits data with 2 stop bits but accepts data with single stop bit.

3. Setting the USB2ANY internal timeout to make sure USB2ANY waits for enough time to receive the
data while at lower baud rates.

2.3.2.2 ADC Settings
• The page has options to enable VREF and set the Analog Power.

Figure 2-16. Enable Analog Config

• The enable VREF button enables/disables the ADC_EN_VREF bit
• The Analog Power button enables the SD bit when set to ShutDown Mode and disables it when set to

Out of ShutDown mode.
• The page contains the settings for ADC1, ADC2 and ADC3 grouped under corresponding tabs.
• The table at the bottom of the page is used to read the ADC register values and display the

corresponding amplitudes in volts. For ADC1 and ADC2 click on the Read ADC button to read the
values.

http://www.ti.com
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Figure 2-17. ADC1 Settings

• For ADC3 select any one of the option from the ADC3 Selection dropdown and then click on Read
ADC button. Note that the gain value is different for each selection and make sure that proper gain is
selected before reading the ADC data.

http://www.ti.com
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Figure 2-18. ADC3 Settings

• The data could also be dumped into a file by selecting the corresponding ADC in the
TRACE_FIFO_ENABLE drop down. This will enable the READ FIFO button and configure the Trace
source.

• Provide a folder path where the ADC values that are read from the TRACE FIFO has to be saved.
Press READ FIFO button to read data and dump it into a file which gets saved with the present
timestamp as the file name. The read progress is shown when the GUI reads the data from the
development RAM. Note that the file name cannot be specified for the TRACE FIFO dump. It gets
generated by the GUI based on the time at which TRACE FIFO read gets completed.

http://www.ti.com
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Figure 2-19. Trace FIFO

• When the user presses the Read FIFO Button, the following set of operations are performed,
– The REMAP bit in the Register is set to zero to come out of the OTP
– The FIFO is flushed
– The FIFO is enabled again to have a fresh data on the DEVRAM
– GUI waits till TRACE FIFO is full. Then the GUI starts reading from the DEVRAM

• The waveform generation section of the ADC page is used to generate continuous Sine wave. Steps to
generate sine wave:
1. Specify required values in GAIN_CTRL, SEM, DAC_VCM, DIFF_VOCM, Skip Filter.
2. Specify required offset for the wave to be generated in WFM Bias. The range for this value is 0.82

to 0.88
3. Specify the amplitude for the sine wave in WFM Amplitude. The range of WFM Amplitude value

depends on the GAIN_CTRL, SEM and WFM_Bias Value in the following manner.
• In Single-Ended Mode

WFM_Amplitude < (WFM_Bias - 0.15)/GAIN_CTRL
• In Differential mode

WFM_Amplitude < 1.235 - WFM Bias
When GUI is initializing WFM Amplitude and WFM_BIAS controls will be loaded with typical
values. User can able to change the values during runtime and when entered value lies outside
limit or if it is not satisfying the above condition, Popup will be displayed and entered value will
be coerced to proper value.

4. Specify the frequency with which the wave has to be generated in WFM Frequency. The range for
frequency is 1 kHz to 20 kHz.

5. After specifying the waveform parameters, press Populate Waveform Table button. The Waveform
table gets populated with the values that has to be written to the Waveform RAM. No. of Samples
shows the number of samples required to generate quarter of the specified sine wave. The table
values can be edited and number of samples can also be specified manually through No. of
Samples edit box. There can be between 1 and 256.

6. To write the table values to the device, click the Write button at the bottom of waveform table.
7. Clear will erase the waveform table values. Save and Open is used to save the waveform data to a

text file or load the waveform data from a text file.
8. Click Generate button to generate the waveform. When the button is clicked, a set of registers

related to the waveform generation gets written to the device.
9. After the waveform generation starts, click the Stop button to stop the waveform generation.
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Figure 2-20. Waveform Generation

2.3.2.3 ADC Capture
• The ADC Capture Page allows the user to configure the required ADC configuration and perform a

continuous ADC capture.
• This page allows the user to switch between ADC Codes and Voltages.
• The Register dropdown is used to switch between the various ADCs and the Gain dropdown sets

corresponding gain to the selected ADC.
• If Mode is Voltage, the graph displays the voltage values and if the Mode is ADC Code, then the graph

displays the ADC register values. Mode can also be selected to Degree or Fahrenheit when
temperature ADC Register is selected to view the data in degree or Fahrenheit scale.

• Check or uncheck the Read Phase? Selection to read the Phase value of ADC. This option will be
available only for ADC1 and ADC2 registers.

• After the required configurations are done on the UI, the capture can be started by clicking the Start
button.

• The continuous capture data will be displayed on the waveform graph on the UI
• Click the Stop button to stop the capture at any point of time.
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• To export the ADC data to a text file, Right click the graph area and select Export data from the
shortcut menu. From the dialog box that appears, select a text file to which the values has to be
stored. Maximum number of samples that can be stored to a file is 1024 samples.

• To export the ADC data to a text file, Right click the graph area and select Export data from the
shortcut menu. From the dialog box that appears, select a text file to which the values has to be
stored. Maximum number of samples that can be stored to a file is 1024 samples.

NOTE: When Read Phase? Option is selected, ADC data read will perform using USB2ANY
scripting.

Figure 2-21. ADC Capture
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2.3.2.4 DAC Settings
The DAC Settings Page contain the DAC features of the device that’s has been explained in the below
sections.

DAC Configuration
• The device includes a 14-bit digital-to-analog converter that produces an absolute output voltage with

respect to the Accurate Reference voltage or ratio metric output voltage with respect to the VDD
supply.

• The DAC can be disabled by writing 0 to DAC_ENABLE bit in DAC_CTRL_STATUS register. When
the microprocessor undergoes a reset, the DAC registers are driven to 0x000 codes.

• The page also has options to Write and Read the DAC registers data.

Figure 2-22. DAC Settings

Ratio Metric vs. Absolute
• The DAC output can be configured to be either in ratiometric-to-VDD mode or independent-of-VDD (or

absolute) mode using the DAC_RATIOMETRIC bit in DAC_CONFIG.
• In Ratio metric mode, changes in the VDD voltage result in a proportional change in the output voltage

because the current reference for the DAC is derived from VDD.

Figure 2-23. Configure DAC

DAC Gain
• The DAC Gain buffer is a configurable buffer stage for the DAC Output.
• In voltage output mode, DAC Gain can be configured for a specific gain value by setting the

DAC_GAIN bits in DAC_CONFIG register to a specific value.
• The DAC Gain can be configured to one of five possible gain configurations using the 2 bit DAC_GAIN

field.
• The final stage of DAC Gain is connected to Vddp and Ground. This gives the ability to drive VOUT

voltage close to VDD voltage.
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2.3.2.5 FRAM and DEVRAM
This page describes the FRAM and DEVRAM programming functionalities of the PGA970 EVM as shown
in Figure 2-24. Each of the device functions are discussed in the following sections.

Figure 2-24. FRAM and DEVRAM

FRAM Programming
• FRAM memory is 8-bit addressable.
• In order to allow the Communication interface to access these memories using 8-bit address, the

memory space is organized as 256-byte/page.
• There are a total of 32 pages.
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Load FRAM Memory
• The data to be written to the OTP is provided to the GUI as a HEX file. A typical HEX file is shown in

Figure 2-25.

Figure 2-25. Sample HEX File

• Select the HEX file path by selecting the browse button as shown in Figure 2-26. The OTP memory is
programmed with the contents of the HEX file, after the Load FRAM button is clicked.
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Figure 2-26. FRAM Programming

• If the Verify FRAM button is pressed the GUI compares the contents of the FRAM memory with the
selected HEX file. If the FRAM memory matches the contents of the .HEX file, the status will be
updated from Not Matched to Matched and the LED glows.

Verify FRAM function does the below activities:
• It reads all the 32 pages of the FRAM registers
• Verifies if the data that is read from the device is same as the data present in the HEX file. The

verification module ignores the registers that are not present in the HEX file.
• If all the register data matches, the status is updated as Matched and the LED glows.
• A verification log file is generated in the directory, parallel to the selected HEX file, with the file name

same as the selected hex file but succeeded with a text _Verification_Log. This file contains the details
(Address, Hex File data and Device Data, both in decimal representation) about all the locations where
the verification modules encountered a data mismatch.
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DEVRAM Programming
• PGA970 has 32 pages of Development RAM with 256 registers each that can overlay the FRAM

memory address. This is to allow convenient programming of the device.
• If the REMAP button is clicked, the GUI sets the REMAP bit to 1
• Always ensure that the REMAP is disabled before loading DEVRAM so that the data gets written to the

correct memory and not to the FRAM
• DEVRAM also implements verify feature similar to FRAM verify which will compare the DEVRAM data

against the selected HEX file data. If both the data matches, the status is updated to Matched and the
LED glows.

Figure 2-27. DEVRAM Programming

1. Browse the .HEX file path to load the Hex file to the GUI
2. Click on Load DEVRAM button to start programming the DEVRAM. The status bar shows the progress

of DEVRAM programing.
3. Click on Verify DEVRAM button to compare DEVRAM data against the hex file selected in step 1. The

status bar shows the progress of DEVRAM verification. A log file is created parallel to the selected hex
file. This log file contains details of all the registers that mismatched with the HEX file data.

4. Browse the path to save the DEVRAM data
5. Click on Read Dev RAM to read the data from Development RAM and save to a file. The status of

read is shown by the progress bar.
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2.4 Menu Options

2.4.1 File
The File menu contains the Exit option as shown in Figure 2-28. The File Menu → Exit option is used to
stop the execution of the PGA970 GUI.

Figure 2-28. File Menu

2.4.2 Script
• Scripting is used to automate the device operations and reduce the time consumption while repeating

similar operations.
• This is helpful in situations where, performing a particular device function required setting 10 to 15

registers to a particular value. In these circumstances, scripts could be recorded and run whenever
needed.

• In PGA970 GUI, the scripting is done using Python because,
– It’s easier to implement
– More widely used
– More user friendly

2.4.2.1 Performing Macro Recording
• To create a custom macro, click Script->Launch Window,

Figure 2-29. Launch Window
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• Python IDLE window appears as shown below.

Figure 2-30. Python Idle Window

NOTE: Selecting the Launch Window again opens another untitled window and the one opened last
will be active.

• Click Script → Start Recording, IDLE window becomes green showing that recording has started

Figure 2-31. Start Recording
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• Go to Low Level Configuration Page of PGA970, select AFEDIAG register and write 10 to Data control
and press Write Register. Action is recorded as shown in Figure 2-32.

Figure 2-32. Macro Recording

• Stop the recording by clicking on Script → Stop Recording.

Figure 2-33. Stop Recording
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• Python IDLE window will no longer be green indicating that the recording has been stopped.

Figure 2-34. Finished Macro Recording

• Run the script by either clicking on Run → Run Module in the IDLE window or press F5.

Figure 2-35. Run Module
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• Save As dialog appears asking for the file name for the script.
• Specify a relevant name (Test.py) and click Save.

NOTE: Name of the script should have the extension .py

Figure 2-36. Save Browser Window
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• The script runs and the status is displayed in the shell window as shown below,

Figure 2-37. Run Saved Macro

• To see the results, refer to the register values in the application and they will be the same as
configured by the script. Read Register operation can also be recorded similarly.
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2.4.3 Debug
he Debug option can be used for the following operations:
• Interface Disconnected - By selecting the Interface Disconnected submenu, the PGA970 GUI is run

in USB2ANY Disconnected mode and by deselecting it, the PGA970 GUI is run in connected mode.
• File Logging - The log to file submenu is used to log the GUI activities to a log file that will be created

at [Public Documents]\Texas Instruments\PGA970\Trace Log. The file name will be time stamp.
• Debugging - The Debug log option will enable the user to log all the activities of the user. If that is not

selected, only the high level operations will be logged.

Figure 2-38. Debug Menu
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2.4.4 Help

2.4.4.1 About
• About dialog can be accessed from Help Menu → About
• The about dialog contains information such as GUI Name, Version Information and Supported OS.
• It also contains copyright information of the PGA970 GUI.

Figure 2-39. About
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